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Software License Agreement 
 

BY INSTALLING THIS SOFTWARE, YOU ARE CONSENTING TO BE BOUND BY THIS AGREEMENT. 

IF YOU DO NOT AGREE TO ALL OF THE TERMS OF THIS AGREEMENT, DO NOT INSTALL THE 

PRODUCT.  

 

Single User License Grant: Ludlum Measurements, Inc. ("Ludlum") and its suppliers grant to Customer 

("Customer") a nonexclusive and nontransferable license to use the Ludlum software ("Software") in 

object code form solely on a single central processing unit owned or leased by Customer or otherwise 

embedded in equipment provided by Ludlum.  

 

Customer may make one (1) archival copy of the Software provided Customer affixes to such copy all 

copyright, confidentiality, and proprietary notices that appear on the original.  

 

EXCEPT AS EXPRESSLY AUTHORIZED ABOVE, CUSTOMER SHALL NOT:  COPY, IN WHOLE OR 

IN PART, SOFTWARE OR DOCUMENTATION; MODIFY THE SOFTWARE; REVERSE COMPILE OR 

REVERSE ASSEMBLE ALL OR ANY PORTION OF THE SOFTWARE; OR RENT, LEASE, 

DISTRIBUTE, SELL, OR  CREATE DERIVATIVE WORKS OF THE SOFTWARE.  

 

Customers agree that aspects of the licensed materials, including the specific design and structure of 

individual programs, constitute trade secrets and/or copyrighted material of Ludlum. Customer agrees not 

to disclose, provide, or otherwise make available such trade secrets or copyrighted material in any form to 

any third party without the prior written consent of Ludlum. Customer agrees to implement reasonable 

security measures to protect such trade secrets and copyrighted material. Title to Software and 

documentation shall remain solely with Ludlum.  

 

LIMITED WARRANTY. Ludlum warrants that for a period of ninety (90) days from the date of shipment 

from Ludlum: (i) the media on which the Software is furnished will be free of defects in materials and 

workmanship under normal use; and (ii) the Software substantially conforms to its published 

specifications. Except for the foregoing, the Software is provided AS IS. This limited warranty extends 

only to Customer as the original licensee. Customer's exclusive remedy and the entire liability of Ludlum 

and its suppliers under this limited warranty will be, at Ludlum or its service center's option, repair, 

replacement, or refund of the Software if reported (or, upon request, returned) to the party supplying the 

Software to Customer. In no event does Ludlum warrant that the Software is error free or that Customer 

will be able to operate the Software without problems or interruptions.  

 

This warranty does not apply if the software (a) has been altered, except by Ludlum, (b) has not been 
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installed, operated, repaired, or maintained in accordance with instructions supplied by Ludlum, (c) has 

been subjected to abnormal physical or electrical stress, misuse, negligence, or accident, or (d) is used in 

ultra hazardous activities.  

 

DISCLAIMER. EXCEPT AS SPECIFIED IN THIS WARRANTY, ALL EXPRESS OR IMPLIED 

CONDITIONS, REPRESENTATIONS, AND WARRANTIES INCLUDING, WITHOUT LIMITATION, ANY 

IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 

NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE 

PRACTICE, ARE HEREBY EXCLUDED TO THE EXTENT ALLOWED BY APPLICABLE LAW. IN NO 

EVENT WILL LUDLUM OR ITS SUPPLIERS BE LIABLE FOR ANY LOST REVENUE, PROFIT, OR 

DATA, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL, OR PUNITIVE DAMAGES 

HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY ARISING OUT OF THE 

USE OF OR INABILITY TO USE THE SOFTWARE EVEN IF LUDLUM OR ITS SUPPLIERS HAVE 

BEEN ADVISED OF THE POSSIBILITY OF SUCH.  

 

DAMAGES. In no event shall Ludlum's or its suppliers' liability to Customer, whether in contract, tort 

(including negligence), or otherwise, exceed the price paid by Customer. The foregoing limitations shall 

apply even if the above-stated warranty fails of its essential purpose. SOME STATES DO NOT ALLOW 

LIMITATION OR EXCLUSION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES.  

 

The above warranty DOES NOT apply to any beta software, any software made available for testing or 

demonstration purposes, any temporary software modules or any software for which Ludlum does not 

receive a license fee. All such software products are provided AS IS without any warranty whatsoever.  

 

This License is effective until terminated. Customer may terminate this License at any time by destroying 

all copies of Software including any documentation. This License will terminate immediately without notice 

from Ludlum if Customer fails to comply with any provision of this License. Upon termination, Customer 

must destroy all copies of Software.  

 

Software, including technical data, is subject to U.S. export control laws, including the U.S. Export 

Administration Act and its associated regulations, and may be subject to export or import regulations in 

other countries. Customers agree to comply strictly with all such regulations and acknowledges that it has 

the responsibility to obtain licenses to export, re-export, or import Software.  

 

This License shall be governed by and construed in accordance with the laws of the State of Texas, 

United States of America, as if performed wholly within the state and without giving effect to the principles 

of conflict of law. If any portion hereof is found to be void or unenforceable, the remaining provisions of 

this License shall remain in full force and effect. This License constitutes the entire License between the 

parties with respect to the use of the Software.  
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Restricted Rights - Ludlum's software is provided to non-DOD agencies with RESTRICTED RIGHTS and its 
supporting documentation is provided with LIMITED RIGHTS. Use, duplication, or disclosure by the 
Government is subject to the restrictions as set forth in subparagraph "C" of the Commercial Computer 
Software - Restricted Rights clause at FAR 52.227-19. In the event the sale is to a DOD agency, the 
government's rights in software, supporting documentation, and technical data are governed by the restrictions 
in the Technical Data Commercial Items clause at DFARS 252.227-7015 and DFARS 227.7202. The 
manufacturer is Ludlum Measurements, Inc. 501 Oak Street Sweetwater, Texas 79556. 
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Introduction 

Getting Started 
 

General Description 

 

The Model 9-4 and 3100 Series Calibration Software is a useful software tool that allows reading and 

writing of many important parameters in Ludlum instruments via an FTDI serial port. Compatible Ludlum 

instruments include the Model 3100 and other instruments in that series and the Model 9-4, and may 

include others. (For the rest of this manual, when referring to the Model 3100, that will also include 

others in the Model 3100 series.) Instrument parameters may be loaded or saved to files, and an 

instrument parameter report may be printed. Current readings or measurements may be streamed from 

the instrument and viewed.   

 

Software Prerequisites 

 

Microsoft .Net 4.5 comes installed on most machines by default. 

  

Minimum Requirements 

 

• Supported Operating Systems: Windows 7 and higher (32-bit and 64-bit versions) 

• Computer with Intel or compatible 1 GHz or faster processor (2 GHz or faster is recommended) 

• Minimum of 256 MB of RAM (1 GB or more is recommended) 

• 1 GB of free hard disk space. 

 

Installation 

 

Run the installer MSI from the installation CD and follow the on-screen prompts to install the LMI Model 

9-4 and 3100 Calibration Software. 
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How to Use Software 

 

Instrument Model Selection Screen 

This window is where the user selects an instrument to which to connect. Please select the proper 

instrument, or else experience errors. 

 

Instrument Connection Screen 

This window shows currently connected Ludlum instruments plugged into a compatible use dongle, and 

the Mac address of that dongle. 

 

 

 

If one were to plug in an instrument after getting to this page, the user will have to hit the refresh 

button.  
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Model 9-4 

 

Main Screen 

The main screen consists of a tabbed interface separating the general calibration operations 

from the restore settings operations and a menu bar.  

Menu Bar 

The menu bar offers quick access to common functions including the File Menu, the Parameters 

Menu, and the Help Menu. 

File Menu 

• Disconnect Instrument: This menu item will disconnect from the instrument and 

take you back to the device selection screen. 

• Print: This menu item will send a report of all parameters to a printer. 

• Exit: This menu item will exit out of the software. 

Parameters Menu 

• Update (Ctrl-U): This menu item is the same as clicking on the "Update" button. 

• Load from File (Ctrl-O) 9-4 only: This menu item loads in settings from a user-

defined text file. 

• Save to File (Ctrl-S) 9-4 only: This menu item will save the current settings to a 

user-defined file. 

• Reload All Data (Ctrl-R): This menu item will reload all data from the instrument 

and refresh the restore values. 

• Print Parameters (Ctrl-P): This menu item will send a report of all parameters to 

a printer. 

Calibration Configurations Tab 

The Calibration Configurations Tab is the tab which should have focus during the calibration and 

configuration of the Model 9-4 Main Board. Using this tab during configuration, the user can 

configure sampling, delays, and compensations required for proper operation of the Model 9-4. 

Using this tab during calibration, the user can calibrate the meter face, enter calibration 

constants for all ranges, and calibrate the pressure sensor. 

Instrument Serial Number 

This box is used to enter the six-digit serial number of the instrument being calibrated. This 
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value is used during print parameters to obtain a printout with the current instrument 

parameters and the instrument serial number. 

Battery Calibration Constant 

This value is the calibration constant for determining a low-battery condition. The value range is 

1 to 65535. 

Range Calibration Constants (X1 - X10K) 

These values are the calibration constants for each range of the meter. The value ranges is 1 to 

65535. 

Calibration Low Pressure 

This number represents the actual low pressure (kPa) that the instrument pressure sensor is 

exposed to when setting the low-pressure calibration. The range of this value is 0.00 to 115.00 

kPa.   

Calibration High Pressure 

This number represents the actual high pressure (kPa) that the instrument pressure sensor is 

exposed to when setting the high-pressure calibration. The range of this value is 0.00 to 115.00 

kPa. 

Pressure Calibration Button 

When the value of the calibration low or high-pressure is changed, this button is highlighted 

and enabled. Calibration low and high values are not sent to the instrument until the button is 

pressed and all the calibration steps are completed. The highlighted button state simply 

indicates changes have been made and serves as a reminder to send the information to the 

instrument. See the calibration section for details on the calibration procedures. 

Temperature Compensation 

When selected, the instrument readings will be corrected based on changes in ambient 

temperature. 

Pressure Compensation 

When selected, the instrument readings will be corrected based on changes in ambient 

pressure. 

Meter Reset 

When selected, the meter operates in the normal default mode. 



5 
 

Test Meter UCP 

When selected, the meter needle is deflected towards the mark indicating the expected reading 

when the instrument is calibrated at the Upper Calibration Point. 

Test Meter LCP 

When selected, the meter needle is deflected towards the mark indicating the expected reading 

when the instrument is calibrated at the Lower Calibration Point. 

Meter Full Scale 

When selected, the meter needle is deflected to full scale and the Up and Down buttons are 

enabled. The Up and Down buttons are to be used to adjust the meter needle to exactly full 

scale. The 'Adjust By Value' is the numerical value the ADC value is adjusted by, and a larger 

number (max of 20) will make the needle move further each time a button is pressed. Fine 

tuning can be made by setting the 'Adjust By Value' to 1. 

Meter Zero Scale 

When selected, the meter needle is deflected to zero on the scale, and the Up and Down 

buttons are enabled. The Up and Down buttons are used just as they are used for Meter Full 

Scale; however, now the needle is being moved to exactly 0 on the display. 

Battery Voltage 

This indicates the instrument’s current battery voltage. 

Temperature 

This indicates the ambient temperature of the instrument. 

Uncompensated Pressure 

This indicates the pressure measured by the instrument pressure sensor. 

Compensated Pressure 

This indicates the pressure measure by the instrument pressure sensor with the value 

compensated for the ambient temperature. 
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Pressure Sample Period 

This indicates the amount of time, 1 to 36000 (where 1 equals 100 ms), between pressure and 

temperature samples used to determine the atmospheric pressure. 

Electrometer Transient Delay 

This indicates the amount of time 1 to 100 (where 1 equals 100 ms) the electrometer will hold 

and display the last reading after pressing the reset button in order to reduce transients 

resulting from the reset action. 

Update Button 

When pressed, the instrument is updated with values that have changed. When values have 

been changed, the Update button will be highlighted until the instrument has been updated 

with the new changes.  

Restore Tab 

The Restore Tab is the tab which should have focus if it is necessary to restore previously saved 

settings into a Model 9-4. Simply hold down the CTRL key and press O and select the file to 

load. Next, press Restore Parameters to load the previously saved parameters into the Model 9-

4. In addition to the calibration constants seen on the Calibration Configurations tab, the 

restore feature also loads the following values. 

Meter Full Scale DAC Value 

This is the digital-to-analog converter numerical value (0 – 4095) that results in a specific 

analog voltage output to place the meter needle at the full-scale position. 

Meter Zero Scale DAC Value 

This is the digital-to-analog converter numerical value (0 – 4095) that results in a specific 

voltage output to place the meter needle at the zero scale position. 

Low Pressure ADC Value 

This is the analog-to-digital converter numerical value (0 – 1023) that results from the 

analog voltage from the pressure sensor, which represents the low-pressure value for 

the instrument. 

High Pressure ADC Value 

This is the analog-to-digital converter numerical value (0 – 1023) that results from the 

analog voltage from the pressure sensor, which represents the high-pressure value for 

the instrument. 
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Restore Low Pressure 

This is the low-pressure value, in kPa, that represents the low-pressure calibration point 

for the instrument. 

Low Pressure Calibrated 

If checked, this indicates that the value stored in the Restore Low Pressure text box is 

the result of an actual low-pressure calibration reading. 

This is the high-pressure value, in kPa, that represents the high-pressure calibration 

point for the instrument. 

High Pressure Calibrated 

If checked, this indicates that the value stored in the Restore High Pressure text box is 

the result of an actual high-pressure calibration reading. 

Calibration Temperature 

This is the temperature, in Celsius, during the high-pressure calibration of the 

instrument. 

Restore Parameters Button 

When pressed, this button sends the values present in the Restore tab to the instrument 

to restore specific calibration values. 
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Model 3100 

Menu Bar 

The menu bar offers quick access to common functions including the File Menu, the Parameters 

Menu, and the Help Menu. 

File Menu 

• Disconnect Instrument: This menu item will disconnect from the instrument and 

take you back to the device selection screen. 

• Print: This menu item will send a report of all parameters to a printer. 

• Exit: This menu item will exit out of the software. 

Parameters Menu 

• Update (Ctrl-U): This menu item is the same as clicking on the "Update" button. 

• Reload All Data (Ctrl-R): This menu item will reload all data from the instrument 

and refresh the restore values. 

• Print Parameters (Ctrl-P): This menu item will send a report of all parameters to 

a printer. 
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Main Screen 

The main screen consists of a tabbed interface separating the general calibration operations 

from the restore settings operations and a menu bar. 

 

 

 

 

 

 

 

 

 

 

Calibration Configurations Tab 

The Calibration Configurations Tab is the tab which should have focus during the calibration and 

configuration of the Model 3100 Main Board. Using this tab during configuration, the user can 

configure sampling, delays, and compensations required for proper operation of the Model 

3100. Using this tab during calibration, the user can calibrate the meter face, enter calibration 

constants for all ranges, and calibrate the pressure sensor. 

Instrument Serial Number 

This box is used to enter the six-digit serial number of the instrument being calibrated. This 

value is used during print parameters to obtain a printout with the current instrument 

parameters with the instrument serial number included. 

Update Button 

When pressed, the instrument is updated with values that have changed. When values have 

been changed, the Update button will be highlighted until the instrument has been updated 

with the new changes.  
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Pressure and Airflow Calibration 
Airflow Calibration Constant 

This represents the adjustment number to the flow reading to ensure it reads correctly. Default should 

be approximately 1.3. 

Airflow Reference 

This represents the pressure at which the airflow was calibrated. It should be the same number used to 

calculate the top point of the pressure slope.   

Calibration Pressure Slope 

This represents the slope of the line for the pressure calibration. If the pressure reading on the 

instruments do not seem to line up by different factors on the bottom and the top, then this should be 

adjusted. 

Calibration Pressure Offset 

This number represents the offset to the pressure (kPa) that the instrument pressure sensor reads. If 

both the top end and the lower end are off by about the same factor, then this should be adjusted. 

Pressure Calibration Button 

This starts the Pressure Calibration Wizard, automatically calculating the values for slope and offset 

based on the two kPa points you set for reference. 
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³H calibration 
 

Meter Offset 

This value sets the offset for the meter. It is set in volts. 

Board ADC Value 

This button reads the value for the board ADC in volts. Please note to read this and 

properly ground the alarm potentiometer. 

Note: The refresh button will quickly read this value when pressed.  

Board ADC Offset 

This value sets the offset for the board ADC in volts. 

Electrometer Offset 

This sets the offset for the electrometer ADC in volts. 

Range Calibration Constants (X1 - X10K) 

These values are the calibration constants for each range of the meter. The value range 

is 1 to 65535.   

Range Selection 

This selection manually sets which range the instrument should be in. It will reset to 

Automatic (0) each time the instrument is turned on and off. The manual range 

selection is used for calibrating the calibration constants.   

Single Point Calibrate Calibration Constants 

When pressed, this will bring up another window, which will assist in calibrations that 

use a single point. 

Electrometer Offset Wizard 

When pressed, this will bring up another window, which will assist in calibrating the 

electrometer offset. 

Miscellaneous 

Unit 

This selects the unit for the device: 
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1. Micro curie per meter cubed 

2. Mega becquerel per meter cubed 

Alert Set Point 

This sets the computer settable alert point for the Model 3100; the unit is the currently 

selected unit. 

Check Source Mode 

This sets what check source your instrument expects; it can use either the 

internal/simulated check source or an external one. 

Check Source Target Reading 

This sets the target reading for the check source check. The unit is the current one for 

the instrument.  

Accumulated Pump Time 

This number is a measurement in hours of how long the pump has been used. This 

number is accumulated during the life of the pump, and it may help with maintenance 

or replacement decisions.  

Reset Accumulated Pump Time Button 

This button will reset the accumulated pump run time to zero in case the pump is 

replaced. 

Real Time Stream 

This displays the contents of the screen, such as temperature in Celsius, pressure in Kpa, airflow 

in L/min, and battery in raw DC voltages.  

Write Stream Speed 

This value sets the current stream speed the instrument outputs in seconds. This must 

be set before starting the stream.  

Write Stream to File 

Checking this will open a new prompt to select a location to save a file of the output 

data.  
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Start 

This button starts the streaming of data from the instrument to the computer. 

Stop 

This button stops the streaming of data from the instrument to the computer. 

 

Calibration Constant Calibration Wizard Description 
 

 

 

1. Radiation Reference 

This is where the user inputs the radiation the device is currently in for calibration. 

2. Count Time 

This allows you to select the amount of time to take a reading for the next run for the 

Calibration Constant Calibration Wizard. The longer the time one takes to select, the 
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more accurate the average will be. 

3. Take Readings 

Clicking this button will start taking Radiation Readings. 

4. Reading History 

This is the history for the Radiation Readings for the current run.  The newest reading is 

always added to the top of the list. 

5. Percentage Done Progress Bar 

This indicates the progress of the current run of the Calibration Constant Calibration 

Wizard and how far to completion. 

6. Average Reading 

This displays the current average of the Radiation Readings. 

7. Back Calculated Calibration Constant 

This is the estimated Calibration Constant to get the Average Reading to match the 

Radiation Reference value. 

8. Calibration Constant 

This is the Calibration Constant to send to the device. 

9. Update Button 

Clicking this button will send the value in the Calibration Constant to the device. 

10. Retake Readings 

Clicking this button will clear the history of Radiation Readings and start taking the 

Radiation Readings again. 

11. Stop Button 

Clicking this button will stop the current run of taking the Radiation Readings. 

12. Reset Radiation Button 

Clicking this button will allow you to change the Radiation Reference value.  Note that 

this will also force you to retake the Radiation Readings. 
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13. Done Button 

Clicking this button will close the Wizard. 

 

How to Use the Constant Calibration Wizard 

 

1. Input the Radiation Reference value. 

1. Select the count time for which to take the Radiation Readings. 

2. Click the Taking Readings button to start taking Radiation Readings. 

3. Wait for the progress bar to fill, indicating that the counting time has 

elapsed. 

4. If the Average Reading is close to the Radiation Reference value, go to step 8. 

5. Copy the Back Calculated Calibration Constant and/or adjust the Calibration 

Constant as needed – increase the Calibration Constant to increase the 

average or decrease the Calibration Constant to lower the average. 

6. Click the Update button to send the new value to the device. 

7. Restart at step 1. 

8. Click the Done button to close the Wizard. 

 

How to Stop Taking the Radiation Readings 

 

1. Click either the Take Readings button or the Retake Readings button to start 

taking Radiation Readings. 

2. Before the progress bar has filled, click the Stop button to stop taking 

readings. 

 

How to Change an Incorrect Radiation Reference Value after Taking the Radiation Readings 

 

1. Click either the Take Readings button or the Retake Readings button to start 

taking Radiation Readings. 

2. After ending the Radiation Readings, either by stopping them or waiting for 

the Readings to finish being taken, click the Reset Radiation button. 
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How to Retake the Radiation Readings 

 

1. Click the Take Readings button to start taking Radiation Readings. 

2. Before the progress bar has filled, click the Stop button to stop taking 

readings. 

3. Click the Retake Readings button. 

 

Electrometer Offset Wizard Description 

 

1. ADC History 

This is the history of all readings for the current run of the Electrometer Offset Wizard.  

The newest reading is always added to the top of the list. 

2. Percentage Done Progress Bar 

This indicates the progress of the current run of the Electrometer Offset Wizard and 

how far to completion. 

3. Count Time 

This allows the user to select the amount of time to take reading for the next run for the 

Electrometer Offset Wizard. The longer the time taken in selecting, the more accurate 

the Filtered Average will be. 
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4. Raw Average ADC 

 This displays the current average of the ADC readings. 

5. Filtered Average ADC 

 This displays the current well filtered average of the ADC readings. 

6. Electrometer Offset 

 This is the Electrometer Offset to send to the device. 

7. Update Button 

 Clicking this button will send the value in the Electrometer Offset to the device. 

8. Start Button 

 Clicking this button will start taking the ADC values. 

9. Stop Button 

 Clicking this button will stop the wizard from taking more ADC Readings. 

10. Done Button 

 Clicking this button will close the Wizard. 

 

How to Use the Electrometer Offset Wizard 

 

1. Select the count time for which you would take the ADC value. 

2. Click the Start button to start taking ADC values. 

3. Wait for the progress bar to fill, indicating that the counting time has elapsed. 

4. If the Filtered Average ADC is close to zero, go to step 8. 

5. Adjust the Electrometer Offset as needed – increase the Electrometer Offset to 

increase the average or decrease the Electrometer Offset to lower the average. 

6. Click the Update button to send the new value to the device. 

7. Restart at step 1. 

8. Click the Done button to close the Wizard. 
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How to Stop the Electrometer Offset Wizard While it is Running 

 

1. Click the Start button to start taking ADC values. 

2. Before the progress bar has filled, click the Stop button to stop taking readings. 

 

Pressure Calibration Wizard Description 

 

1. Step Description 

 This shows which Pressure Calibration Window you are currently in. 

2. Pressure Reference 

 This is where you input the pressure the device is currently in for calibration. 
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3. Take Voltage Readings 

 Clicking this button will start taking the Voltage Readings. 

4. Pressure Voltage History 

This is the history for the Voltage Readings for the current run. The newest reading is 

always added to the top of the list. 

5. Percentage Done Progress Bar 

This indicates the progress of the current run of the Pressure Calibration Wizard and 

how long until completion. 

6. Average Voltage 

 This displays the current average of the Voltage readings. 

7. Retake Voltage Button 

Clicking this button will clear the history of Voltage Readings and start taking the 

Voltage Readings again. 

8. Stop Button 

 Clicking this button will stop the current run of taking the Voltage Readings. 

9. Reset Pressure Button 

Clicking this button will allow you to change the Pressure Reference value.  Note that 

this will also force you to retake the Voltage Readings. 

10. Cancel Button 

Clicking this button will cancel the Pressure Calibration Wizard in its entirety, making no 

changes to the Pressure Calibration Slope and Pressure Calibration Offset fields as a 

result. 

11. Accept Button 

Clicking this button will either continue to the High Pressure Window (if you are in the 

Low Pressure Window) or calculate the Pressure Calibration Slope and Pressure 

Calibration Offset and close the High Pressure Window. 
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How to Use the Pressure Calibration Wizard 

 

1. Input the Low Pressure reference value. 

2. Click the Take Voltage Readings button. 

3. Wait for the progress bar to fill, indicating that all of the Voltage Readings have been 

gathered. 

4. Click the Accept button. 

5. The Low Pressure Window will now close, and the High Pressure Window will open. 

6. Input the High Pressure reference value. 

7. Click the Take Voltage Readings button. 

8. Wait for the progress bar to fill, indicating that all of the Voltage Readings have been 

gathered. 

9. Click the Accept button. 

10. The new values will be placed into the Pressure Calibration Slope and Pressure 

Calibration Offset fields.  Remember to click the Update button to send these new 

values to the device. 

 

How to Stop Taking the Voltage Readings 

 

1. Click either the Take Voltage Readings button or the Retake Voltage button to start 

taking Voltage Readings. 

2. Before the progress bar has filled, click the Stop button to stop taking readings. 

 

How to Change an Incorrect Pressure Reference Value after Taking the Pressure Voltage 

Readings 

 

1. Click either the Take Voltage Readings button or the Retake Voltage button to start 

taking Voltage Readings. 

2. After ending the Voltage Readings, either by stopping them or waiting for the 

Readings to finish being taken, click the Reset Pressure button. 
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How to Retake the Voltage Readings 

 

1. Click the Take Voltage Readings button to start taking Voltage Readings. 

2. Before the progress bar has filled, click the Stop button to stop taking readings. 

3. Click the Retake Voltage button. 
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Version History 
 

Version 2.0.13.0 
Model 9-4 

• Fixed bug where the Low Pressure Status and High Pressure Status were no longer being read at 

start up. 

• Fixed error in saving the parameters to a file where it did not put each value on its own line. 

• Fixed error in saving the parameters to a file where the Low Pressure Calibration Status and the 

High Pressure Calibration Status were the wrong values. 

• Fixed error where the ADC Samples value was not being read (to be shown on the Print and Save 

to a file Parameters). 

• Fixed bug where Load Parameters from File would read the parameters from the device instead. 

 

Version 2.0.12.0 

• Unreleased due to change in plan for 3100. 

 

Version 2.0.11.0 
Model 3100 

• Changed the Board ADC field to only allow values from 5 to -5 to match the device. 

 

Version 2.0.10.0 
Model 9-4 

• Fixed bug where the Pressure Calibration would fail if the Low Pressure Calibration Status 

checkbox and/or the Low Pressure Calibration Status checkbox are unchecked. 

 

Version 2.0.9.1 
Model 9-4 

• Removed unnecessary spacing in the Print Page. 
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Version 2.0.9.0 
Model 9-4 

• Fixed bug where the Print would not print the correct values for Temperature, Low Pressure 

Status, and High Pressure Status. 

• Fixed bug where the Temperature Compensated value would be sent as the opposite value. 

 

Version 2.0.8.0 
Model 9-4 

• Fixed bug where the Meter Zero Scale DAC and Meter Full Scale DAC values was claimed to not 

be sent when they were. 

• Fixed bug where the software would claim the connection was lost when it was not. 

 

Version 2.0.7.0 
Model 3100 

• Fixed issue where the Calibration Wizards and Electrometer Wizard would take longer than 

indicated to run. 

• Changed the Calibration Wizards to indicate what range the user was Calibrating. 

 

Version 2.0.6.0 
Model 3100 

• Fixed bug where the Air Flow Reference would not be updated by the Pressure Calibration 

Wizard. 

• Fixed bug where the Pressure Calibration Wizard did not load the original Cal Const value. 

• Fixed bug where the Pressure Calibration Wizard did not copy the calculated Cal Const value to 

the main screen. 

• Added a specialized Single Point Calibration Constant Wizard. 

• Fixed bug where the user could click the Update button of the Calibration Wizards at any time 

rather than when it has completed. 

• Fixed issue where the Calibration Wizards would always show the units as μCi, even if the device 

was in MBq. 

• Fixed issue where the Main Window would not re-read the Alarm Set Point and Check Source 

Target Reading after changing the Units. 

• Fixed issue where the Wizards would freeze whenever the window is being moved around. 
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Model 9-4 

• Fixed bug where setting the Restore Meter Zero Scale value, it would set the restore Meter Full 

Scale value instead. 

 

Version 2.0.5.0 
Initial Release. 
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Troubleshooting 

Missing .Net (DotNet) Framework  
DotNet Framework comes with most standard Windows desktops. However, if for some reason while 

installing or after installation you are still missing the .Net Framework, please go to the MSDN (Microsoft 

Developer Network) website and download 4.5 Framework for your machine. 

No Devices Showing Up 
 

1. Check to make sure everything is properly connected.  

2. Make sure FTDI drives included on the CD are downloaded and installed properly. 

3. If the drivers are correctly downloaded, check to see if Microsoft Windows is still installing the 

drivers for the instrument. This may take a few moments. (If you have multiple new instruments 

on a daily basis, FAQ question, “Calibration on different devices,” may speed this up.) 

4. Make sure the instrument is on, and if it is, try turning it off and then on again. 

5. Change cable.  

6. Check dongle. Sometimes while installing the driver, you may run into an issue, i.e. power shuts 

off, instrument unplugged, Windows update, etc. This may cause your driver to become corrupt, 

and the instrument will no longer show in the software. To check for this issue, follow these 

steps. 

If none of the above solves your issue, please feel free to call Ludlum Measurements. 

 

Calibration on Different Devices – first plug in 
 

If your computer is running Windows 7 or higher, when a new device is connected to your computer, 

Windows may spend up to 15 minutes searching for the drivers through Windows Update. This is 

unnecessary and time consuming if you are plugging in different new instruments. In order to avoid this, 

you need to change some system settings on handling drivers: 

Windows 7 

• Click Start, right-click Computer, and choose Properties. 
• In the Tasks list, click Advanced System Settings. 
• On the System Properties dialog box, click the Hardware tab, and then click Windows Update 

Driver Settings. 
• Finally, select “only if not found on local machine.” 

Windows 8 and 10 
For Windows 8 (and higher), you only get the choice of using Windows Update always or never. 
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• Search for "Change device install" in the Windows 8 Start menu and select “change device 
installation settings.”  

• In answer to the question "do you want Windows to download driver software," choose "no, let 
me choose what to do," and then select "never" and save changes. 
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Cables 
LMI wiring on the Model 3100 9-pin D connector has the two required relay connections  - one for 

sampling and one for alarm – which makes it non-standard, so when Ludlum Measurements supplies a 

software kit, it has an adapter cable (LMI part # 8303-1038). This cable can be used in conjunction with 

cables a user already has. Cable 8303-1038 has a phone connector at one end and a 9-pin D connector 

at the other end. At the computer, this adapter can connect the Model 3100 directly to a USB adapter. If 

the user has a long cable stretching over to a gamma calibration range, an easily obtained RJ12 phone 

coupler may be needed to join the two cables (shown below, left).  

          

In the above, top-right figure, the phone plug is shown up close. The lower-right figure above is the         

9-pin D connector portion of the cable depicted up close. 

 

Ludlum Measurements also makes a one-piece cable that goes directly from a USB connection (from a 

PC) to a 9-pin D connector (Model 3100), skipping the phone coupler. LMI can supply this cable as 

needed. The part # for this cable is 8520-159. Again, this cable is custom made because of the non-

standard wiring on the 9-pin D connector. See the following figures. 
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The left figure shows the RS-232 to USB cable for 

direct connection to a PC. The above figure 

depicts the 9-pin D connector portion of the cable 

up close.  


